
 

  

 
Modbus User’s Manual 

V1.0_11082022 

 

  



 

  

TABLE OF CONTENTS 
 INTRODUCTION ................................................................................................................................... 1 
 DEFINITIONS ........................................................................................................................................ 1 
 WIRING SETUP .................................................................................................................................... 1 

 Two-Wire ......................................................................................................................... 1 

 Four-Wire ........................................................................................................................ 1 

 Line Termination ............................................................................................................. 2 

 Line Polarization (Biasing) ............................................................................................... 2 

 Line Shielding and Wiring ................................................................................................ 2 

 MODBUS CONFIGURATIONS ............................................................................................................. 3 
 PHASETECH UI OPERATION ............................................................................................................. 3 

 Start Up ........................................................................................................................... 3 

 Configuration .................................................................................................................. 3 

 Changing Parameters ...................................................................................................... 4 

 Relays .............................................................................................................................. 4 

 MESSAGE STRUCTURE + FUNCTION CODES ................................................................................. 5 

 Read Coil – Function Code 1(0x01) ................................................................................. 5 

 Read Discrete Inputs – Function Code 2(0x02) ............................................................... 6 

 Read Holding Registers – Function Code 3(0x03) ........................................................... 6 

 Read Input Registers – Function Code 4(0x04) ............................................................... 7 

 Write Single Coil – Function Code 5(0x05) ...................................................................... 7 

 Write Single Holding Register – Function Code 6(0x06) ................................................. 7 

 Diagnostics – Function Code 8(0x08) .............................................................................. 8 

6.7.1 Return Query Data – Sub Function Code 0 ....................................................... 8 

6.7.2 Restart Communications – Sub Function Code 1 .............................................. 8 



 

  

6.7.3 Force Listen Only Mode – Sub Function Code 4 ................................................ 9 

6.7.4 Clear Counters – Sub Function Code 10 ............................................................ 9 

6.7.5 Return Bus Message Count – Sub Function Code 11 ........................................ 9 

6.7.6 Return Bus Comm Error Count – Sub Function Code 12 ................................... 9 

6.7.7 Return Bus Exception Error Count – Sub Function Code 13 .............................. 9 

6.7.8 Return Server Message Count – Sub Function Code 14 .................................. 10 

6.7.9 Return Server No Response Count – Sub Function Code 15 ........................... 10 

6.7.10 Return Server NAK Count – Sub Function Code 16 ......................................... 10 

 Report Slave ID – Function Code 17(0x11) .................................................................... 10 

 Extended Diagnostics – Function Code 65 (0x41) ......................................................... 10 

 Phase Command – Function Code 66 (0x42) ............................................................... 11 

6.10.1 Set HOA Mode –Function Code 66/1(0x42/0x01) ........................................... 11 

6.10.2 Set Run State – Function Code 66/2(0x42/0x02) ............................................ 12 

6.10.3 Reset System Status – Function Code 66/3(0x42/0x03) ................................. 12 

 Unimplemented Function Codes ................................................................................. 12 

 MODBUS COMMUNICATION SPECIFICATIONS ............................................................................. 14 

 TX Line Holding .............................................................................................................. 14 

 LH Aqua Phase Series .................................................................................................... 14 

 LH-V Series ..................................................................................................................... 15 

 MODBUS ADDRESSES ..................................................................................................................... 16 
 REFERENCES .................................................................................................................................... 19 

 



 

1 | P a g e  
 

 INTRODUCTION 
 
The following documentation provides information on how to setup, configure, and operate the Modbus 
communications interface with Phase VFDs. 
 
The Modbus protocol states each device must have these data categories: Coils, Discrete Inputs, 
Holding Registers, and Input Registers. These categories hold all accessible Read/Write and Read Only 
parameters and measurements available through the Modbus interface. 
 

 DEFINITIONS 
 
Master: Device that transmits and requests information to and from Slave devices 
Slave: Device that receives requests from and responds to a Modbus Master device 
Coil: Single bit (on/off) Read/Write value 
Discrete Input: Single bit (on/off) Read Only value 
Holding Register: Read/Write 16 bit register 
Input Register: Read Only 16 bit register 
 

 WIRING SETUP 
 

 Two-Wire 
 
To wire the control board using two-wire communication, first short the two positive lines, R+ and T+ 
together. This becomes the D1(+) line. Next, short together the R- and T- lines together, this becomes 
the D0(-) line.  
 
If communicating directly to a drive using an RS-485 four-wire adapter, the positive lines should be 
shorted, and the negative lines should be shorted together. 
 
If the PhaseTech UI is used, the adapter is configurable, and has an Echo Mode feature, the Echo 
Mode must be turned ON to mimic the echo of a four-wire adapter wired in the two-wire configuration. 
 

 Four-Wire 
 
To wire the control board to a four-wire network, connect the following: 

• Master’s T+ to Slave’s R+ 
• Master’s T- to Slave’s R- 
• Master’s R+ to Slave’s T+ 
• Master’s R- to Slave’s T- 
• Common grounds must be connected as well 

 
• Adapters with the Echo Mode feature must be turned OFF. 
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 Line Termination 
 
A Modbus network must have one 120Ohm 1/4W resistor at each end of a Modbus balanced line pair. 
In two-wire communication, 2 termination resistors are used, and in four-wire communication, a total of 
four line termination resistors must be used.  
 
If a Phase Technologies VFD is at either end of a Modbus network, a termination resistor may be 
installed in the Terminal Block on the control board. 
 
When communicating directly to a Phase VFD Slave using an adapter, it may be useful to provide 
termination resistors at either end of the line. Depending on how long the cable is, the baud rate, and 
the type of shielding used, adding termination resistors may improve the quality of communication 
between Master and Slave. 
 

 Line Polarization (Biasing) 
 
Providing a bias for Phase VFDs is not necessary for operation, but can still function if connected to a 
biased network. Phase VFDs do not supply line biasing by default. +5V and ground terminals are 
available, but it is recommended that the biasing resistors be close to the Master device. 450-650 Ohm 
resistors must be used, and it is required that only one bias resistor be on each data line.  
 
Note: To avoid excess loading on a network with bias resistors, the maximum number of devices on a 
single network without a repeater is reduced from 32 to 28. 
 
When communicating directly to a Phase VFD Slave using an adapter, it may also be useful to provide 
biasing resistors. The 5VO and COM ports on the control board terminals may be used to provide the 
+5V and ground for biasing. 
 

 Line Shielding and Wiring 
 
The Modbus standard requires shielded twisted-pair cabling, as this aids the most in mitigating noise 
interference. In a Modbus network, it is not recommended to tie the shielding of the cable to the Phase 
VFD’s COM port, and instead should be grounded near the Master device. 
 
When communicating directly to a Phase VFD Slave using an adapter, it is recommended to tie the 
shielding to ground via the control board’s COM screw terminal, and not to the adapter itself. 
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 MODBUS CONFIGURATIONS 
 
Modbus ID – Modbus network device address from 1 to 247. The Modbus ID of the Phase VFD must 
be the only device on that network with that value, otherwise multiple devices will read and respond to 
the same message. 
Modbus Data Rate – Baud Rate of the network. 2400*, 4800, 9600, 19200, 38400, 57600, and 
115200* rates are supported. *Only the LH-V series supports these baud rates. 
Modbus Parity – Parity Bit enable/configuration. Even, Odd, and None parities are supported. 
Modbus Stop Bits – The number of stop bits following a byte, 1 or 2 are supported. 
Modbus Wiring – Select between two and four-wire communication. 
 
When using the PhaseTech UI program, it is important to match the configurations between the Phase 
VFD and the UI’s configurations under the Options menu. 
 

 PHASETECH UI OPERATION 
 
Phase Technologies provides a Windows application to communicate with Phase VFDs. 
 

 Start Up 
 
To begin, run the application PhaseTechUI.exe. When ran for the first time, the user will be prompted to 
select a Phase VFD control. Select “LH Aqua Phase Control” for LH Aqua Phase systems or “LH-V 
Control” for LH-V systems. 
 
Once the main page is loaded, use the Modbus Slave Address Select box to type in the Modbus ID of 
the Phase VFD. Click Set to configure the PhaseTech UI to communicate with the selected device.  
 
Next, use the drop down menu in the top right labeled “Port Select” to select the COM Port that is being 
used by the RS-485 adapter. If the COM Port is not found, make sure the adapter is plugged in and 
connected to the Phase VFD, and ensure that drivers are installed correctly. Either click the Reset 
button or restart the PhaseTech UI program to reload the COM Port list. 
 
After selecting the correct COM Port, click the Connect button, and automatic communication with the 
VFD will begin. Parameters will load their current values into the “Current” column. 
 

 Configuration 
 
To configure the Default, Min, and Max columns, double click the table’s Cell that you wish to change. A 
text box will appear prompting for a new value. New Min values cannot be lower than the default Min 
values, and new Max values cannot be higher than the default Max values. 
 
Changing either the Min or Max value of a parameter will automatically adjust the Default value, and it 
will ensure that the Default value cannot be set below or above the Min or Max values. 
 
Any changes made will be highlighted in red text. Once done configuring the Defaults, the configuration 
can be saved under File->Save, or by pressing Control+S. A prompt will appear to give the save file a 
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name and a file location. If the user exits the program with unsaved changes, the PhaseTech UI will ask 
if the changes should be saved. 
 
Note: Parameters cannot be set higher or lower than the Phase VFD’s model parameter min/max 
values. For example, Overcurrent Limit cannot be set higher than 48A on 30HP systems. 
 
A configuration file can be loaded under File->Open to load a previous configuration. The default 
configuration can be loaded under File->Reset Default Params. This will load the default parameter 
configurations. 
 

 Changing Parameters 
 
To write to a Read/Write parameter address, either type in the Register Address in the text box, use the 
Register Name dropdown menu, or click the row of the parameter to select that parameter. Type in a 
Value that is in the Min/Max range of that parameter, and click the Send button. Allow for a few seconds 
for the parameter to be updated in the table. 
 
The user can use the Apply Defaults button to sequentially send all Default values to every Read/Write 
parameter. 
 

 Relays 
 
To control the relays through Modbus, the Interface Parameter “Program Relay No x” must be set to 
“Modbus Control”, otherwise, the command to toggle the relay will be ignored. 
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 MESSAGE STRUCTURE + FUNCTION CODES 
 
Message Structure 
Every Modbus message must contain a Slave ID, a Function Code, and a two-byte CRC. Two-byte 
register number and data fields must always be “Big-Endian” where the high byte is transmitted first, 
followed by the low byte. Every two-byte CRC must be transmitted with the low byte transmitted first, 
followed by the high byte. 
 
Example request to read 4 Coils starting from Address 0: 
Slave ID 1 Byte 1 
Function Code 1 Byte 0x01 
Starting Register 2 Bytes[Hi:Lo] [0x00, 0x00] 
Number of Coils 2 Bytes[Hi:Lo] [0x00, 0x04] 
CRC 2 Bytes[Lo:Hi] [CRCL, CRCH] 
 
Note 1: In the following sections, the Slave ID and CRC fields will be excluded, as every request and 
response will need these fields. 
 
Note 2: The category offsets must not be added to the address field before sending a request. To 
access Coil number 1 the address must be 0, to access Discrete Input Register 10002 the address 
must be 1, etc. 
 

 Read Coil – Function Code 1(0x01) 
 
Coil Register Start: 00001 
Request:  
Function Code 1 Byte 0x01 
Starting Address 2 Bytes[H:L] 0 to 3 
Number of Coils 2 Bytes[H:L] 1 to 4 
 
Response: 
Function Code 1 Byte 0x01 
Data Byte Count 1 Byte 1 
Coil Statuses 1 Byte Bit Field 
Note: Bit Field contains the status of each requested coil.  
The 1st requested coil is in Bit 0, the 2nd requested coil is in Bit 1, etc. 
 
Error Response: 
Function Code 1 Byte 0x81 
Exception Code 1 Byte 02 or 03 
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 Read Discrete Inputs – Function Code 2(0x02) 
 
Discrete Input Start: 10001 
Request:  
Function Code 1 Byte 0x02 
Starting Address 2 Bytes[H:L] 0 to 7 
Number of Inputs 2 Bytes[H:L] 1 to 8 
 
Response: 
Function Code 1 Byte 0x02 
Data Byte Count 1 Byte 1 
Coil Statuses 1 Byte Bit Field 
Note: Bit Field contains the status of each discrete input.  
The 1st requested input is in Bit 0, the 2nd requested input is in Bit 1, etc. 
 
Error Response: 
Function Code 1 Byte 0x82 
Exception Code 1 Byte 02 or 03 
 

 Read Holding Registers – Function Code 3(0x03) 
 
Holding Register Start: 40001 
Note 1: In LH AquaPhase systems, N is limited to 6 registers. In LH-V systems, N is limited to 30 
registers in a single response. 
 
Request:  
Function Code 1 Byte 0x03 
Starting Address 2 Bytes[H:L] 0 to 136 
Number of Registers 2 Bytes[H:L] 1 to N* 
 
Response: 
Function Code 1 Byte 0x03 
Data Byte Count 1 Byte  2 x N* 
Register Value 0 2 Bytes[H:L] Value 
      …….      
Register Value [N* - 1] 2 Bytes[H:L] Value 
 
Error Response: 
Function Code 1 Byte 0x83 
Exception Code 1 Byte 02 or 03 
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 Read Input Registers – Function Code 4(0x04) 
 
Input Register Start: 30001 
Note *: In LH AquaPhase systems, N is limited to 6 registers. In LH-V systems, N is limited to 30 
registers in a single response. 
 
Request:  
Function Code 1 Byte 0x04 
Starting Address 2 Bytes[H:L] 0 to 28 
Number of Registers 2 Bytes[H:L] 1 to N* 
 
Response: 
Function Code 1 Byte 0x04 
Data Byte Count 1 Byte  2 x N* 
Register Value 0 2 Bytes[H:L] Value 
      …….      
Register Value [N* - 1] 2 Bytes[H:L] Value 
 
Error Response: 
Function Code 1 Byte 0x84 
Exception Code 1 Byte 02 or 03 
 

 Write Single Coil – Function Code 5(0x05) 
 
Request:  
Function Code 1 Byte 0x05 
Coil Address 2 Bytes[H:L] 0 to 3 
Coil Value 2 Bytes[H:L] 0x0000(off) or 0xFF00(on) 
 
Response: 
Function Code 1 Byte 0x05 
Coil Address 2 Bytes[H:L] 0 to 3 
Coil Value 2 Bytes[H:L] 0x0000(off) or 0xFF00(on) 
 
Error Response: 
Function Code 1 Byte 0x85 
Exception Code 1 Byte 02 or 03 
 

 Write Single Holding Register – Function Code 6(0x06) 
 
Request Message:  
Function Code 1 Byte 0x06 
Register Address 2 Bytes[H:L] 0 to 136 
Register Value 2 Bytes[H:L] 0x0000 to 0xFFFF 
 
  



 

8 | P a g e  
 

Response: 
Function Code 1 Byte 0x06 
Register Address 2 Bytes[H:L] 0 to 136 
Register Value 2 Bytes[H:L] 0x0000 to 0xFFFF 
 
Error Response: 
Function Code 1 Byte 0x86 
Exception Code 1 Byte 02 or 03 
 

 Diagnostics – Function Code 8(0x08) 
 
All Diagnostic messages and responses will have the same format. 
Request:  
Function Code 1 Byte 0x08 
Sub Function Code 2 Bytes[H:L] [Sub Function Code] 
Data 2 Bytes[H:L] [Data] 
 
Response: 
Function Code 1 Byte 0x08 
Sub Function Code 2 Bytes[H:L] [Sub Function Code] 
Data 2 Bytes[H:L] [Data] 
 
Error Response: 
Function Code 1 Byte 0x88 
Exception Code  1 Byte 01, 03, 04 
 

6.7.1 Return Query Data – Sub Function Code 0 
 
Sub Function Code: 0x0000 
Data: Any 
Response: Echo Data 

6.7.2 Restart Communications – Sub Function Code 1 
 
Sub Function Code: 0x0001 
Data: Any 
Response: Echo Request Data 
 
Note 1: Event Log is not implemented. Setting Data to 0xFF00 will not affect the Restart 
Communications command. 
 
Note 2: This is the only command that the drive will act on when in Listen Only Mode. Sending this 
command will reset communications, and Listen Only Mode will be disabled. If the drive is coming out of 
Listen Only Mode, no response message will be sent. 
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6.7.3 Force Listen Only Mode – Sub Function Code 4 
Sub Function Code: 0x0004 
Data: 0x0000 
Response: No Response 
 
This command will force the drive into Listen Only Mode. The drive can receive Modbus messages, but 
it will perform no actions, and give no responses. The only way to set the drive to normal Modbus 
operation is to send the Diagnostics - Restart Communications command, and no response will be 
given. Future requests will be acted on and responded to. 
 

6.7.4 Clear Counters – Sub Function Code 10 
Sub Function Code: 0x000A 
Data: 0x0000 
Response: Echo Data 
 
This command clears all Modbus and SCI counters. The Diagnostics register is not implemented. All 
counters are reset when the drive powers up. 
 

6.7.5 Return Bus Message Count – Sub Function Code 11 
Sub Function Code: 0x000B 
Data: 0x0000 
Response: Total Message Count 
 
The drive will respond with the total number of Modbus Messages that it has seen.  
 

6.7.6 Return Bus Comm Error Count – Sub Function Code 12 
Sub Function Code: 0x000C 
Data: 0x0000 
Response: CRC Error Count 
 
The drive will respond with the total number of CRC errors.  
 

6.7.7 Return Bus Exception Error Count – Sub Function Code 13 
Sub Function Code: 0x000D 
Data: 0x0000 
Response: Exception Error Count 
 
The drive will respond with the total number of Illegal Function, Address, and Value errors.  
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6.7.8 Return Server Message Count – Sub Function Code 14 
Sub Function Code: 0x000E 
Data: 0x0000 
Response: Server Message Count 
 
The drive will respond with the total number of Modbus Messages that have been addressed to that 
device. 
 

6.7.9 Return Server No Response Count – Sub Function Code 15 
Sub Function Code: 0x000F 
Data: 0x0000 
Response: No Response Count 
 
The drive will respond with the total number of Modbus Messages that it has not responded to.  
 

6.7.10 Return Server NAK Count – Sub Function Code 16 
Sub Function Code: 0x0010 
Data: 0x0000 
Response: Server NAK Count 
 
The drive will respond with the total number of Negative Acknowledge exception responses. 
 
 

 Report Slave ID – Function Code 17(0x11) 
 
Request Message:  
Function Code 1 Byte 0x11 
 
Response: 
Function Code 1 Byte 0x11 
Byte Count 1 Byte 3 
Slave ID 1 Byte Slave ID 
Run Status 1 Byte 0x00(off) or 0xFF(on) 
System Status 1 Byte 0(ok), positive number = Fault 
 

 Extended Diagnostics – Function Code 65 (0x41) 
 
Extended Diagnostics Start: 60001 
 
This is a Phase Technologies specific function code, which functions similar to the Input Registers 
(function code 4). The extended diagnostics register array contains all of the Modbus and SCI counters 
and parameter offsets and counts. 
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Note *: In LH AquaPhase systems, N is limited to 6 registers. In LH-V systems, N is limited to 30 
registers in a single response. 
 
Request Message:  
Function Code 1 Byte 0x41 
Starting Address 2 Bytes[H:L] 0 to 21 
Number of Registers 2 Bytes[H:L] 1 to N* 
 
Response: 
Function Code 1 Byte 0x41 
Data Byte Count 1 Byte  2 x N* 
Register Value 0 2 Bytes[H:L] Value 
      …….      
Register Value [N* - 1] 2 Bytes[H:L] Value 
 
Error Response: 
Function Code 1 Byte 0xC1 
Exception Code 1 Byte 02 or 03 
 
 

 Phase Command – Function Code 66 (0x42) 
 
This is a Phase Technologies specific function code with multiple sub-function codes. 
 

6.10.1 Set HOA Mode –Function Code 66/1(0x42/0x01) 
This will set the drive into Off, Manual, or Auto Mode.  
 
Request:  
Function Code 1 Byte 0x42 
Sub Function Code 2 Bytes[H:L] 0x0001 
Mode Select 1 Byte 0x00(Off), 0x0F(Manual), 0xF0(Auto) 
 
Response: 
Function Code 1 Byte 0x42 
Sub Function Code 2 Bytes[H:L] 0x0001 
Mode Select 1 Byte Echo Data 
 
Error Response: 
Function Code 1 Byte 0xC2 
Sub Function Code  2 Bytes[H:L] 0x0081 
Exception Code 1 Byte 03 
 



 

12 | P a g e  
 

6.10.2 Set Run State – Function Code 66/2(0x42/0x02) 
If the drive is in Manual Mode, this command will Run/Stop the drive. If the Interface Parameter: 
Disable Manual Mode is configured to “Yes”, this command will not toggle the run state of the drive. 
 
Request:  
Function Code 1 Byte 0x42 
Sub Function Code 2 Bytes[H:L] 0x0002 
Mode Select 1 Byte 0x00(Off), 0x0F(Run) 
 
Response: 
Function Code 1 Byte 0x42 
Sub Function Code 2 Bytes[H:L] 0x0002 
Mode Select 1 Byte Echo Data 
 
Error Response: 
Function Code 1 Byte 0xC2 
Sub Function Code  2 Bytes[H:L] 0x0082 
Exception Code 1 Byte 03 
 

6.10.3 Reset System Status – Function Code 66/3(0x42/0x03) 
If the drive is in a Fault State, this command will reset the drive. This command will only work if the 
system has faulted. The System Reset byte must be 0xA5 for the command to work. 
 
Request:  
Function Code 1 Byte 0x42 
Sub Function Code 2 Bytes[H:L] 0x0003 
System Reset Data 1 Byte 0xA5 
 
Response: 
Function Code 1 Byte 0x42 
Sub Function Code 2 Bytes[H:L] 0x0003 
System Reset Data 1 Byte Echo Data 
 
Error Response: 
Function Code 1 Byte 0xC2 
Sub Function Code  2 Bytes[H:L] 0x0083 
Exception Code 1 Byte 03 
 
 

 Unimplemented Function Codes 
 
Read Exception Status – 7(0x07)  
Get Comm Event Counter – 11(0x0B) 
Get Comm Event Log – 12(0x0C) 
Write Multiple Coils – 15(0x0F) 
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Write Multiple Registers – 16(0x10) 
Read File Record – 20(0x14) 
Write File Record – 21(0x15) 
Mask Write Register – 22(0x16) 
Read/Write Multiple Registers – 23(0x17) 
Read FIFO Queue – 24(0x18) 
Encapsulated Interface Transport – 43(0x2B) 
CANopen General Request and Response PDU – 43/13 (0x2B/0x0D) 
Read Device Identification – 43/14 (0x2B/0x0E) 
 
Error Response: 
Function Code 1 Byte 0x80 | [Function Code] 
Exception Code 1 Byte 01 
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 MODBUS COMMUNICATION SPECIFICATIONS 
 

 TX Line Holding 
 
On the TX+/- lines in 4-Wire communication, and the D0/D1 lines in 2-Wire communication, both the 
LHAP and LH-V series will continue to drive the bus for a set amount of time to ensure that the entire 
message has been transmitted successfully. 
 
Baud Rate Delay Amount (ms) 

2400* 6.0 
4800 4.0 
9600 2.0 

19200 1.0 
38400 0.4 
57600 0.4 

115200* 0.2 
 
*These baud rates are only available on LH-V systems 
 

 LH Aqua Phase Series 
 
Baud Rate Calculations 
Clock Source Expected Baud Rate Actual Baud Rate % Error 

60M 4800 4804 0.08% 
60M 9600 9615 0.16% 
60M 19200 19231 0.16% 
60M 38400 38461 0.16% 
60M 57600 57692 0.16% 

 
3.5 Char Silent Interval 
Baud Rate 3.5 Char Time (ms) 

4800 8.0 
9600 4.0 

19200 2.0 
38400 1.8 
57600 1.8 

 
1.5 Char Frame Timing 
Baud Rate 3.5 Char Time (ms) 

4800 3.6 
9600 1.8 

19200 1.0 
38400 0.8 
57600 0.8 
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 LH-V Series 
 
Baud Rate Calculations 
Clock Source Expected Baud Rate Actual Baud Rate % Error 

120M 2400* 2400 0.0% 
120M 4800 4800 0.0% 
120M 9600 9603 0.03% 
120M 19200 19206 0.03% 
120M 38400 38363 0.10% 
120M 57600 57692 0.16% 
120M 115200* 115384 0.16% 

 
3.5 Char Silent Interval 
Baud Rate 3.5 Char Time (ms) 

2400* 16.0 
4800 8.0 
9600 4.0 

19200 2.0 
38400 1.8 
57600 1.8 

115200* 1.8 
 
1.5 Char Frame Timing 
Baud Rate 3.5 Char Time (ms) 

2400* 6.9 
4800 3.5 
9600 1.8 

19200 0.9 
38400 0.8 
57600 0.8 

115200* 0.8 
 
*These baud rates are only available on LH-V systems. 
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 MODBUS ADDRESSES 
 

Index Name Address Read Only 
0 "Relay 1" 1 0 
1 "Relay 2" 2 0 
2 "Relay 3" 3 0 
3 "Relay 4" 4 0 
4 "HOA Run-Stop " 10001 1 
5 "AUX 1 Setting " 10002 1 
6 "AUX 2 Setting " 10003 1 
7 "AUX 3 Setting " 10004 1 
8 "AUX 4 Setting " 10005 1 
9  "Fan_Drive" 10006 1 
10  "Contactor_Drive" 10007 1 
11  "Relay_Drive" 10008 1 
12 "HOA Auto-Manual " 30001 1 
13  "I_u" 30002 1 
14  "I_v" 30003 1 
15  "I_w" 30004 1 
16  "Output HP" 30005 1 
17  "Output KW" 30006 1 
18  "Output KVA" 30007 1 
19  "Output PF" 30008 1 
20  "Bus Cap Voltage" 30009 1 
21  "Input Voltage" 30010 1 
22  "Input Current" 30011 1 
23  "Model Number" 30012 1 
24  "Frequency" 30013 1 
25  "Measured Current Unbalance" 30014 1 
26  "Input Current 2" 30015 1 
27  "Input Current 3" 30016 1 
28  "IGBT Case Temp 1" 30017 1 
29  "IGBT Case Temp 2" 30018 1 
30  "V 5VDC Input" 30019 1 
31  "I_1 4-20mA Input" 30020 1 
32  "I_2 4-20mA Input" 30021 1 
33  "DIP States" 30022 1 
34  "Internal Temp" 30023 1 
35  "RTC Year" 30024 1 
36  "RTC Month" 30025 1 
37  "RTC Day" 30026 1 
38  "RTC Hour" 30027 1 
39  "RTC Minute" 30028 1 
40  "RTC Second" 30029 1 
41 "System Status" 30030 1 
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42  "Output Voltage" 40001 0 
43  "Min Frequency" 40002 0 
44  "Max Frequency" 40003 0 
45  "Start Up Ramp Time" 40004 0 
46  "Overcurrent Limit" 40005 0 
47  "Dry Well Current" 40006 0 
48  "Current Unbalance" 40007 0 
49  "Dry Well KW" 40008 0 
50  "Switching Frequency" 40009 0 
51  "Coast to Stop" 40010 0 
52  "GND Fault Detect Fault Sensitivity" 40011 0 
53  "Submersible Pump" 40012 0 
54  "Reverse Rotation" 40013 0 
55  "Shutdown Ramp" 40014 0 
56  "Overcurrent Derate Enable" 40015 0 
57  "Overtemp Derate Enable" 40016 0 
58 "Minimum Derate Frequency" 40017 0 
59 "PWM Over Modulation" 40018 0 
60  "Pivot Overcurrent" 40019 0 
61  "Enable Restarts" 40020 0 
62  "Dry Well Delay" 40021 0 
63  "Restart Delay 1" 40022 0 
64  "Restart Delay 2" 40023 0 
65  "Restart Delay 3" 40024 0 
66  "Restarts Motor Overload" 40025 0 
67  "Restarts Dry Well" 40026 0 
68  "Restarts Current Imbalance" 40027 0 
69  "Restarts Undervoltage" 40028 0 
70  "Restarts Overvoltage" 40029 0 
71  "Restarts Bus Overvoltage" 40030 0 
72  "Startup Delay" 40031 0 
73  "Restarts 1ph V" 40032 0 
74  "Restarts Sensor Conn Fail" 40033 0 
75  "Restarts 4-20mA" 40034 0 
76  "Short Cycle Delay" 40035 0 
77  "Sensor Connection Fault Delay" 40036 0 
78  "Restarts Locked Motor" 40037 0 
79  "System Config" 40038 0 
80  "Troubleshooting" 40039 0 
81  "Analog Select" 40040 0 
82  "Program Relay 1" 40041 0 
83  "Program Relay 2" 40042 0 
84  "Program Relay 3" 40043 0 
85  "Program Relay 4" 40044 0 
86  "Analog in Reverse" 40045 0 
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87  "MODBUS ID" 40046 0 
88  "MODBUS Data Rate" 40047 0 
89  "MODBUS Parity" 40048 0 
90  "MODBUS Stop Bits" 40049 0 
91  "Disable Manual Mode" 40050 0 
92  "AUX 1 Select" 40051 0 
93  "AUX 2 Select" 40052 0 
94  "AUX 3 Select" 40053 0 
95  "AUX 4 Select" 40054 0 
96  "Broken Pipe psi" 40055 0 
97  "Broken Pipe Time" 40056 0 
98  "T OFF" 40057 0 
99  "T1 ON" 40058 0 
100  "T2 ON" 40059 0 
101  "Shut Off Frequency" 40060 0 
102  "Boost Amount" 40061 0 
103  "Pre-charge Frequency" 40062 0 
104  "Pre-charge Time" 40063 0 
105  "Pre-charge psi" 40064 0 
106  "Proportional Gain" 40065 0 
107  "Integral Gain" 40066 0 
108  "Derivative Gain" 40067 0 
109  "PID Filter Gain" 40068 0 
110  "PID Filter Time" 40069 0 
111  "Overpressure psi" 40070 0 
112  "4-20mA psi Sensor Range" 40071 0 
113  "Duplex Cycle Time" 40072 0 
114  "Draw Down psi" 40073 0 
115  "psi SETPOINT" 40074 0 
116  "psi 1 SETPOINT" 40075 0 
117  "psi 2 SETPOINT" 40076 0 
118  "psi 3 SETPOINT" 40077 0 
119  "psi 4 SETPOINT" 40078 0 
120 "PSI Offset" 40079 0 
121  "Number Lag Pumps" 40080 0 
122  "Stage Pump Dly" 40081 0 
123  "Destage Pump Dly" 40082 0 
124  "Stage Frq Redct1" 40083 0 
125  "Stage Frq Redct2" 40084 0 
126  "Stage Frq Redct3" 40085 0 
127  "Stage Frq Redct4" 40086 0 
128  "Stage Time" 40087 0 
129  "Destg psi Boost1" 40088 0 
130  "Destg psi Boost2" 40089 0 
131  "Destg psi Boost3" 40090 0 
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132  "Destg psi Boost4" 40091 0 
133  "Destage Time" 40092 0 
134  "Stage psi Lag" 40093 0 
135  "Destage psi Lag" 40094 0 
136  "Destage Min Freq" 40095 0 
137  "Precharge Pumps" 40096 0 
138 "Modbus Msg Count" 60001 1 
139 "Modbus Comm Error Count" 60002 1 
140 "Modbus Exception Count" 60003 1 
141 "Modbus Slave Msg Count" 60004 1 
142 "Modbus No Response Count" 60005 1 
143 "Modbus Framing Error Count" 60006 1 
144 "SCI Error Count" 60007 1 
145 "SCI Framing Error Count" 60008 1 
146 "SCI Overrun Error Count" 60009 1 
147 "SCI Parity Error Count" 60010 1 
148 "Operating Start" 60011 1 
149 "Auto Restart Start" 60012 1 
150 "Interface Start" 60013 1 
151 "Constant Pressure Start" 60014 1 
152 "Lead Lag Start" 60015 1 
153 "Operating Count" 60016 1 
154 "Auto Restart Count" 60017 1 
155 "Interface Count" 60018 1 
156 "Constant Pressure Count" 60019 1 
157 "Lead Lag Count" 60020 1 

 
 

 REFERENCES 
 

• http://www.modbus.org/docs/Modbus_over_serial_line_V1_02.pdf 
• http://www.modbus.org/docs/Modbus_Application_Protocol_V1_1b3.pdf 
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[bookmark: _Toc35328440][bookmark: _Ref35353450][bookmark: _Ref35353455][bookmark: _Ref35353462][bookmark: _Toc118800495]INTRODUCTION



[bookmark: _Ref35353595]The following documentation provides information on how to setup, configure, and operate the Modbus communications interface with Phase VFDs.



The Modbus protocol states each device must have these data categories: Coils, Discrete Inputs, Holding Registers, and Input Registers. These categories hold all accessible Read/Write and Read Only parameters and measurements available through the Modbus interface.



[bookmark: _Toc118800496]DEFINITIONS



Master: Device that transmits and requests information to and from Slave devices

Slave: Device that receives requests from and responds to a Modbus Master device

Coil: Single bit (on/off) Read/Write value

Discrete Input: Single bit (on/off) Read Only value

Holding Register: Read/Write 16 bit register

Input Register: Read Only 16 bit register

[bookmark: _Ref35436914][bookmark: _Ref35436932][bookmark: _Ref35436986]

[bookmark: _Toc118800497]WIRING SETUP



[bookmark: _Toc118800498]Two-Wire



To wire the control board using two-wire communication, first short the two positive lines, R+ and T+ together. This becomes the D1(+) line. Next, short together the R- and T- lines together, this becomes the D0(-) line. 



If communicating directly to a drive using an RS-485 four-wire adapter, the positive lines should be shorted, and the negative lines should be shorted together.



If the PhaseTech UI is used, the adapter is configurable, and has an Echo Mode feature, the Echo Mode must be turned ON to mimic the echo of a four-wire adapter wired in the two-wire configuration.



[bookmark: _Toc118800499]Four-Wire



To wire the control board to a four-wire network, connect the following:

· Master’s T+ to Slave’s R+

· Master’s T- to Slave’s R-

· Master’s R+ to Slave’s T+

· Master’s R- to Slave’s T-

· Common grounds must be connected as well



· Adapters with the Echo Mode feature must be turned OFF.






[bookmark: _Toc118800500]Line Termination



A Modbus network must have one 120Ohm 1/4W resistor at each end of a Modbus balanced line pair. In two-wire communication, 2 termination resistors are used, and in four-wire communication, a total of four line termination resistors must be used. 



If a Phase Technologies VFD is at either end of a Modbus network, a termination resistor may be installed in the Terminal Block on the control board.



When communicating directly to a Phase VFD Slave using an adapter, it may be useful to provide termination resistors at either end of the line. Depending on how long the cable is, the baud rate, and the type of shielding used, adding termination resistors may improve the quality of communication between Master and Slave.



[bookmark: _Toc118800501]Line Polarization (Biasing)



Providing a bias for Phase VFDs is not necessary for operation, but can still function if connected to a biased network. Phase VFDs do not supply line biasing by default. +5V and ground terminals are available, but it is recommended that the biasing resistors be close to the Master device. 450-650 Ohm resistors must be used, and it is required that only one bias resistor be on each data line. 



Note: To avoid excess loading on a network with bias resistors, the maximum number of devices on a single network without a repeater is reduced from 32 to 28.



When communicating directly to a Phase VFD Slave using an adapter, it may also be useful to provide biasing resistors. The 5VO and COM ports on the control board terminals may be used to provide the +5V and ground for biasing.



[bookmark: _Toc118800502]Line Shielding and Wiring



The Modbus standard requires shielded twisted-pair cabling, as this aids the most in mitigating noise interference. In a Modbus network, it is not recommended to tie the shielding of the cable to the Phase VFD’s COM port, and instead should be grounded near the Master device.



When communicating directly to a Phase VFD Slave using an adapter, it is recommended to tie the shielding to ground via the control board’s COM screw terminal, and not to the adapter itself.






[bookmark: _Toc118800503]MODBUS CONFIGURATIONS



Modbus ID – Modbus network device address from 1 to 247. The Modbus ID of the Phase VFD must be the only device on that network with that value, otherwise multiple devices will read and respond to the same message.

Modbus Data Rate – Baud Rate of the network. 2400*, 4800, 9600, 19200, 38400, 57600, and 115200* rates are supported. *Only the LH-V series supports these baud rates.

Modbus Parity – Parity Bit enable/configuration. Even, Odd, and None parities are supported.

Modbus Stop Bits – The number of stop bits following a byte, 1 or 2 are supported.

Modbus Wiring – Select between two and four-wire communication.



When using the PhaseTech UI program, it is important to match the configurations between the Phase VFD and the UI’s configurations under the Options menu.



[bookmark: _Toc118800504]PHASETECH UI OPERATION



Phase Technologies provides a Windows application to communicate with Phase VFDs.



[bookmark: _Toc118800505]Start Up



To begin, run the application PhaseTechUI.exe. When ran for the first time, the user will be prompted to select a Phase VFD control. Select “LH Aqua Phase Control” for LH Aqua Phase systems or “LH-V Control” for LH-V systems.



Once the main page is loaded, use the Modbus Slave Address Select box to type in the Modbus ID of the Phase VFD. Click Set to configure the PhaseTech UI to communicate with the selected device. 



Next, use the drop down menu in the top right labeled “Port Select” to select the COM Port that is being used by the RS-485 adapter. If the COM Port is not found, make sure the adapter is plugged in and connected to the Phase VFD, and ensure that drivers are installed correctly. Either click the Reset button or restart the PhaseTech UI program to reload the COM Port list.



After selecting the correct COM Port, click the Connect button, and automatic communication with the VFD will begin. Parameters will load their current values into the “Current” column.



[bookmark: _Toc118800506]Configuration



To configure the Default, Min, and Max columns, double click the table’s Cell that you wish to change. A text box will appear prompting for a new value. New Min values cannot be lower than the default Min values, and new Max values cannot be higher than the default Max values.



Changing either the Min or Max value of a parameter will automatically adjust the Default value, and it will ensure that the Default value cannot be set below or above the Min or Max values.



Any changes made will be highlighted in red text. Once done configuring the Defaults, the configuration can be saved under File->Save, or by pressing Control+S. A prompt will appear to give the save file a name and a file location. If the user exits the program with unsaved changes, the PhaseTech UI will ask if the changes should be saved.



Note: Parameters cannot be set higher or lower than the Phase VFD’s model parameter min/max values. For example, Overcurrent Limit cannot be set higher than 48A on 30HP systems.



A configuration file can be loaded under File->Open to load a previous configuration. The default configuration can be loaded under File->Reset Default Params. This will load the default parameter configurations.



[bookmark: _Toc118800507]Changing Parameters



To write to a Read/Write parameter address, either type in the Register Address in the text box, use the Register Name dropdown menu, or click the row of the parameter to select that parameter. Type in a Value that is in the Min/Max range of that parameter, and click the Send button. Allow for a few seconds for the parameter to be updated in the table.



The user can use the Apply Defaults button to sequentially send all Default values to every Read/Write parameter.



[bookmark: _Toc118800508]Relays



To control the relays through Modbus, the Interface Parameter “Program Relay No x” must be set to “Modbus Control”, otherwise, the command to toggle the relay will be ignored.






[bookmark: _Toc118800509]MESSAGE STRUCTURE + FUNCTION CODES



Message Structure

Every Modbus message must contain a Slave ID, a Function Code, and a two-byte CRC. Two-byte register number and data fields must always be “Big-Endian” where the high byte is transmitted first, followed by the low byte. Every two-byte CRC must be transmitted with the low byte transmitted first, followed by the high byte.



Example request to read 4 Coils starting from Address 0:

		Slave ID

		1 Byte

		1



		Function Code

		1 Byte

		0x01



		Starting Register

		2 Bytes[Hi:Lo]

		[0x00, 0x00]



		Number of Coils

		2 Bytes[Hi:Lo]

		[0x00, 0x04]



		CRC

		2 Bytes[Lo:Hi]

		[CRCL, CRCH]







Note 1: In the following sections, the Slave ID and CRC fields will be excluded, as every request and response will need these fields.



Note 2: The category offsets must not be added to the address field before sending a request. To access Coil number 1 the address must be 0, to access Discrete Input Register 10002 the address must be 1, etc.



[bookmark: _Toc118800510]Read Coil – Function Code 1(0x01)



Coil Register Start: 00001

Request: 

		Function Code

		1 Byte

		0x01



		Starting Address

		2 Bytes[H:L]

		0 to 3



		Number of Coils

		2 Bytes[H:L]

		1 to 4







Response:

		Function Code

		1 Byte

		0x01



		Data Byte Count

		1 Byte

		1



		Coil Statuses

		1 Byte

		Bit Field





Note: Bit Field contains the status of each requested coil. 

The 1st requested coil is in Bit 0, the 2nd requested coil is in Bit 1, etc.



Error Response:

		Function Code

		1 Byte

		0x81



		Exception Code

		1 Byte

		02 or 03










[bookmark: _Toc118800511]Read Discrete Inputs – Function Code 2(0x02)



Discrete Input Start: 10001

Request: 

		Function Code

		1 Byte

		0x02



		Starting Address

		2 Bytes[H:L]

		0 to 7



		Number of Inputs

		2 Bytes[H:L]

		1 to 8







Response:

		Function Code

		1 Byte

		0x02



		Data Byte Count

		1 Byte

		1



		Coil Statuses

		1 Byte

		Bit Field





Note: Bit Field contains the status of each discrete input. 

The 1st requested input is in Bit 0, the 2nd requested input is in Bit 1, etc.



Error Response:

		Function Code

		1 Byte

		0x82



		Exception Code

		1 Byte

		02 or 03







[bookmark: _Toc118800512]Read Holding Registers – Function Code 3(0x03)



Holding Register Start: 40001

Note 1: In LH AquaPhase systems, N is limited to 6 registers. In LH-V systems, N is limited to 30 registers in a single response.



Request: 

		Function Code

		1 Byte

		0x03



		Starting Address

		2 Bytes[H:L]

		0 to 136



		Number of Registers

		2 Bytes[H:L]

		1 to N*







Response:

		Function Code

		1 Byte

		0x03



		Data Byte Count

		1 Byte

		 2 x N*



		Register Value 0

		2 Bytes[H:L]

		Value



		

		     …….    

		



		Register Value [N* - 1]

		2 Bytes[H:L]

		Value







Error Response:

		Function Code

		1 Byte

		0x83



		Exception Code

		1 Byte

		02 or 03










[bookmark: _Toc118800513]Read Input Registers – Function Code 4(0x04)



Input Register Start: 30001

Note *: In LH AquaPhase systems, N is limited to 6 registers. In LH-V systems, N is limited to 30 registers in a single response.



Request: 

		Function Code

		1 Byte

		0x04



		Starting Address

		2 Bytes[H:L]

		0 to 28



		Number of Registers

		2 Bytes[H:L]

		1 to N*







Response:

		Function Code

		1 Byte

		0x04



		Data Byte Count

		1 Byte

		 2 x N*



		Register Value 0

		2 Bytes[H:L]

		Value



		

		     …….    

		



		Register Value [N* - 1]

		2 Bytes[H:L]

		Value







Error Response:

		Function Code

		1 Byte

		0x84



		Exception Code

		1 Byte

		02 or 03







[bookmark: _Toc118800514]Write Single Coil – Function Code 5(0x05)



Request: 

		Function Code

		1 Byte

		0x05



		Coil Address

		2 Bytes[H:L]

		0 to 3



		Coil Value

		2 Bytes[H:L]

		0x0000(off) or 0xFF00(on)







Response:

		Function Code

		1 Byte

		0x05



		Coil Address

		2 Bytes[H:L]

		0 to 3



		Coil Value

		2 Bytes[H:L]

		0x0000(off) or 0xFF00(on)







Error Response:

		Function Code

		1 Byte

		0x85



		Exception Code

		1 Byte

		02 or 03







[bookmark: _Toc118800515]Write Single Holding Register – Function Code 6(0x06)



Request Message: 

		Function Code

		1 Byte

		0x06



		Register Address

		2 Bytes[H:L]

		0 to 136



		Register Value

		2 Bytes[H:L]

		0x0000 to 0xFFFF










Response:

		Function Code

		1 Byte

		0x06



		Register Address

		2 Bytes[H:L]

		0 to 136



		Register Value

		2 Bytes[H:L]

		0x0000 to 0xFFFF







Error Response:

		Function Code

		1 Byte

		0x86



		Exception Code

		1 Byte

		02 or 03







[bookmark: _Toc118800516]Diagnostics – Function Code 8(0x08)



All Diagnostic messages and responses will have the same format.

Request: 

		Function Code

		1 Byte

		0x08



		Sub Function Code

		2 Bytes[H:L]

		[Sub Function Code]



		Data

		2 Bytes[H:L]

		[Data]







Response:

		Function Code

		1 Byte

		0x08



		Sub Function Code

		2 Bytes[H:L]

		[Sub Function Code]



		Data

		2 Bytes[H:L]

		[Data]







Error Response:

		Function Code

		1 Byte

		0x88



		Exception Code 

		1 Byte

		01, 03, 04







[bookmark: _Toc118800517]Return Query Data – Sub Function Code 0



Sub Function Code: 0x0000

Data: Any

Response: Echo Data

[bookmark: _Toc118800518]Restart Communications – Sub Function Code 1



Sub Function Code: 0x0001

Data: Any

Response: Echo Request Data



Note 1: Event Log is not implemented. Setting Data to 0xFF00 will not affect the Restart Communications command.



Note 2: This is the only command that the drive will act on when in Listen Only Mode. Sending this command will reset communications, and Listen Only Mode will be disabled. If the drive is coming out of Listen Only Mode, no response message will be sent.



[bookmark: _Toc118800519]Force Listen Only Mode – Sub Function Code 4

Sub Function Code: 0x0004

Data: 0x0000

Response: No Response



This command will force the drive into Listen Only Mode. The drive can receive Modbus messages, but it will perform no actions, and give no responses. The only way to set the drive to normal Modbus operation is to send the Diagnostics - Restart Communications command, and no response will be given. Future requests will be acted on and responded to.



[bookmark: _Toc118800520]Clear Counters – Sub Function Code 10

Sub Function Code: 0x000A

Data: 0x0000

Response: Echo Data



This command clears all Modbus and SCI counters. The Diagnostics register is not implemented. All counters are reset when the drive powers up.



[bookmark: _Toc118800521]Return Bus Message Count – Sub Function Code 11

Sub Function Code: 0x000B

Data: 0x0000

Response: Total Message Count



The drive will respond with the total number of Modbus Messages that it has seen. 



[bookmark: _Toc118800522]Return Bus Comm Error Count – Sub Function Code 12

Sub Function Code: 0x000C

Data: 0x0000

Response: CRC Error Count



The drive will respond with the total number of CRC errors. 



[bookmark: _Toc118800523]Return Bus Exception Error Count – Sub Function Code 13

Sub Function Code: 0x000D

Data: 0x0000

Response: Exception Error Count



The drive will respond with the total number of Illegal Function, Address, and Value errors. 



[bookmark: _Toc118800524]Return Server Message Count – Sub Function Code 14

Sub Function Code: 0x000E

Data: 0x0000

Response: Server Message Count



The drive will respond with the total number of Modbus Messages that have been addressed to that device.



[bookmark: _Toc118800525]Return Server No Response Count – Sub Function Code 15

Sub Function Code: 0x000F

Data: 0x0000

Response: No Response Count



The drive will respond with the total number of Modbus Messages that it has not responded to. 



[bookmark: _Toc118800526]Return Server NAK Count – Sub Function Code 16

Sub Function Code: 0x0010

Data: 0x0000

Response: Server NAK Count



The drive will respond with the total number of Negative Acknowledge exception responses.





[bookmark: _Toc118800527]Report Slave ID – Function Code 17(0x11)



Request Message: 

		Function Code

		1 Byte

		0x11







Response:

		Function Code

		1 Byte

		0x11



		Byte Count

		1 Byte

		3



		Slave ID

		1 Byte

		Slave ID



		Run Status

		1 Byte

		0x00(off) or 0xFF(on)



		System Status

		1 Byte

		0(ok), positive number = Fault







[bookmark: _Toc118800528]Extended Diagnostics – Function Code 65 (0x41)



Extended Diagnostics Start: 60001



This is a Phase Technologies specific function code, which functions similar to the Input Registers (function code 4). The extended diagnostics register array contains all of the Modbus and SCI counters and parameter offsets and counts.



Note *: In LH AquaPhase systems, N is limited to 6 registers. In LH-V systems, N is limited to 30 registers in a single response.



Request Message: 

		Function Code

		1 Byte

		0x41



		Starting Address

		2 Bytes[H:L]

		0 to 21



		Number of Registers

		2 Bytes[H:L]

		1 to N*







Response:

		Function Code

		1 Byte

		0x41



		Data Byte Count

		1 Byte

		 2 x N*



		Register Value 0

		2 Bytes[H:L]

		Value



		

		     …….    

		



		Register Value [N* - 1]

		2 Bytes[H:L]

		Value







Error Response:

		Function Code

		1 Byte

		0xC1



		Exception Code

		1 Byte

		02 or 03









[bookmark: _Toc118800529]Phase Command – Function Code 66 (0x42)



This is a Phase Technologies specific function code with multiple sub-function codes.



[bookmark: _Toc118800530]Set HOA Mode –Function Code 66/1(0x42/0x01)

This will set the drive into Off, Manual, or Auto Mode. 



Request: 

		Function Code

		1 Byte

		0x42



		Sub Function Code

		2 Bytes[H:L]

		0x0001



		Mode Select

		1 Byte

		0x00(Off), 0x0F(Manual), 0xF0(Auto)







Response:

		Function Code

		1 Byte

		0x42



		Sub Function Code

		2 Bytes[H:L]

		0x0001



		Mode Select

		1 Byte

		Echo Data







Error Response:

		Function Code

		1 Byte

		0xC2



		Sub Function Code 

		2 Bytes[H:L]

		0x0081



		Exception Code

		1 Byte

		03







[bookmark: _Toc118800531]Set Run State – Function Code 66/2(0x42/0x02)

If the drive is in Manual Mode, this command will Run/Stop the drive. If the Interface Parameter: Disable Manual Mode is configured to “Yes”, this command will not toggle the run state of the drive.



Request: 

		Function Code

		1 Byte

		0x42



		Sub Function Code

		2 Bytes[H:L]

		0x0002



		Mode Select

		1 Byte

		0x00(Off), 0x0F(Run)







Response:

		Function Code

		1 Byte

		0x42



		Sub Function Code

		2 Bytes[H:L]

		0x0002



		Mode Select

		1 Byte

		Echo Data







Error Response:

		Function Code

		1 Byte

		0xC2



		Sub Function Code 

		2 Bytes[H:L]

		0x0082



		Exception Code

		1 Byte

		03







[bookmark: _Toc118800532]Reset System Status – Function Code 66/3(0x42/0x03)

If the drive is in a Fault State, this command will reset the drive. This command will only work if the system has faulted. The System Reset byte must be 0xA5 for the command to work.



Request: 

		Function Code

		1 Byte

		0x42



		Sub Function Code

		2 Bytes[H:L]

		0x0003



		System Reset Data

		1 Byte

		0xA5







Response:

		Function Code

		1 Byte

		0x42



		Sub Function Code

		2 Bytes[H:L]

		0x0003



		System Reset Data

		1 Byte

		Echo Data







Error Response:

		Function Code

		1 Byte

		0xC2



		Sub Function Code 

		2 Bytes[H:L]

		0x0083



		Exception Code

		1 Byte

		03









[bookmark: _Toc118800533]Unimplemented Function Codes



Read Exception Status – 7(0x07) 

Get Comm Event Counter – 11(0x0B)

Get Comm Event Log – 12(0x0C)

Write Multiple Coils – 15(0x0F)

Write Multiple Registers – 16(0x10)

Read File Record – 20(0x14)

Write File Record – 21(0x15)

Mask Write Register – 22(0x16)

Read/Write Multiple Registers – 23(0x17)

Read FIFO Queue – 24(0x18)

Encapsulated Interface Transport – 43(0x2B)

CANopen General Request and Response PDU – 43/13 (0x2B/0x0D)

Read Device Identification – 43/14 (0x2B/0x0E)



Error Response:

		Function Code

		1 Byte

		0x80 | [Function Code]



		Exception Code

		1 Byte

		01
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[bookmark: _Toc118800535]TX Line Holding



On the TX+/- lines in 4-Wire communication, and the D0/D1 lines in 2-Wire communication, both the LHAP and LH-V series will continue to drive the bus for a set amount of time to ensure that the entire message has been transmitted successfully.



		Baud Rate

		Delay Amount (ms)



		2400*

		6.0



		4800

		4.0



		9600

		2.0



		19200

		1.0



		38400

		0.4



		57600

		0.4



		115200*

		0.2







*These baud rates are only available on LH-V systems



[bookmark: _Toc118800536]LH Aqua Phase Series



Baud Rate Calculations

		Clock Source

		Expected Baud Rate

		Actual Baud Rate

		% Error



		60M

		4800

		4804

		0.08%



		60M

		9600

		9615

		0.16%



		60M

		19200

		19231

		0.16%



		60M

		38400

		38461

		0.16%



		60M

		57600

		57692

		0.16%







3.5 Char Silent Interval

		Baud Rate

		3.5 Char Time (ms)



		4800

		8.0



		9600

		4.0



		19200

		2.0



		38400

		1.8



		57600

		1.8







1.5 Char Frame Timing

		Baud Rate

		3.5 Char Time (ms)



		4800

		3.6



		9600

		1.8



		19200

		1.0



		38400

		0.8



		57600

		0.8
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Baud Rate Calculations

		Clock Source

		Expected Baud Rate

		Actual Baud Rate

		% Error



		120M

		2400*

		2400

		0.0%



		120M

		4800

		4800

		0.0%



		120M

		9600

		9603

		0.03%



		120M

		19200

		19206

		0.03%



		120M

		38400

		38363

		0.10%



		120M

		57600

		57692

		0.16%



		120M

		115200*

		115384

		0.16%







3.5 Char Silent Interval

		Baud Rate

		3.5 Char Time (ms)



		2400*

		16.0



		4800

		8.0



		9600

		4.0



		19200

		2.0



		38400

		1.8



		57600

		1.8



		115200*

		1.8







1.5 Char Frame Timing

		Baud Rate

		3.5 Char Time (ms)



		2400*

		6.9



		4800

		3.5



		9600

		1.8



		19200

		0.9



		38400

		0.8



		57600

		0.8



		115200*

		0.8







*These baud rates are only available on LH-V systems.
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		Index

		Name

		Address

		Read Only



		0

		"Relay 1"

		1

		0



		1

		"Relay 2"

		2

		0



		2

		"Relay 3"

		3

		0



		3

		"Relay 4"

		4

		0



		4

		"HOA Run-Stop "

		10001

		1



		5

		"AUX 1 Setting "

		10002

		1



		6

		"AUX 2 Setting "

		10003

		1



		7

		"AUX 3 Setting "

		10004

		1



		8

		"AUX 4 Setting "

		10005

		1



		9

		 "Fan_Drive"

		10006

		1



		10

		 "Contactor_Drive"

		10007

		1



		11

		 "Relay_Drive"

		10008

		1



		12

		"HOA Auto-Manual "

		30001

		1



		13

		 "I_u"

		30002

		1



		14

		 "I_v"

		30003

		1



		15

		 "I_w"

		30004

		1



		16

		 "Output HP"

		30005

		1



		17

		 "Output KW"

		30006

		1



		18

		 "Output KVA"

		30007

		1



		19

		 "Output PF"

		30008

		1



		20

		 "Bus Cap Voltage"

		30009

		1



		21

		 "Input Voltage"

		30010

		1



		22

		 "Input Current"

		30011

		1



		23

		 "Model Number"

		30012

		1



		24

		 "Frequency"

		30013

		1



		25

		 "Measured Current Unbalance"

		30014

		1



		26

		 "Input Current 2"

		30015

		1



		27

		 "Input Current 3"

		30016

		1



		28

		 "IGBT Case Temp 1"

		30017

		1



		29

		 "IGBT Case Temp 2"

		30018

		1



		30

		 "V 5VDC Input"

		30019

		1



		31

		 "I_1 4-20mA Input"

		30020

		1



		32

		 "I_2 4-20mA Input"

		30021

		1



		33

		 "DIP States"

		30022

		1



		34

		 "Internal Temp"

		30023

		1



		35

		 "RTC Year"

		30024

		1



		36

		 "RTC Month"

		30025

		1



		37

		 "RTC Day"

		30026

		1



		38

		 "RTC Hour"

		30027

		1



		39

		 "RTC Minute"

		30028

		1



		40

		 "RTC Second"

		30029

		1



		41

		"System Status"

		30030

		1



		42

		 "Output Voltage"

		40001

		0



		43

		 "Min Frequency"

		40002

		0



		44

		 "Max Frequency"

		40003

		0



		45

		 "Start Up Ramp Time"

		40004

		0



		46

		 "Overcurrent Limit"

		40005

		0



		47

		 "Dry Well Current"

		40006

		0



		48

		 "Current Unbalance"

		40007

		0



		49

		 "Dry Well KW"

		40008

		0



		50

		 "Switching Frequency"

		40009

		0



		51

		 "Coast to Stop"

		40010

		0



		52

		 "GND Fault Detect Fault Sensitivity"

		40011

		0



		53

		 "Submersible Pump"

		40012

		0



		54

		 "Reverse Rotation"

		40013

		0



		55

		 "Shutdown Ramp"

		40014

		0



		56

		 "Overcurrent Derate Enable"

		40015

		0



		57

		 "Overtemp Derate Enable"

		40016

		0



		58

		"Minimum Derate Frequency"

		40017

		0



		59

		"PWM Over Modulation"

		40018

		0



		60

		 "Pivot Overcurrent"

		40019

		0



		61

		 "Enable Restarts"

		40020

		0



		62

		 "Dry Well Delay"

		40021

		0



		63

		 "Restart Delay 1"

		40022

		0



		64

		 "Restart Delay 2"

		40023

		0



		65

		 "Restart Delay 3"

		40024

		0



		66

		 "Restarts Motor Overload"

		40025

		0



		67

		 "Restarts Dry Well"

		40026

		0



		68

		 "Restarts Current Imbalance"

		40027

		0



		69

		 "Restarts Undervoltage"

		40028

		0



		70

		 "Restarts Overvoltage"

		40029

		0



		71

		 "Restarts Bus Overvoltage"

		40030

		0



		72

		 "Startup Delay"

		40031

		0



		73

		 "Restarts 1ph V"

		40032

		0



		74

		 "Restarts Sensor Conn Fail"

		40033

		0



		75

		 "Restarts 4-20mA"

		40034

		0



		76

		 "Short Cycle Delay"

		40035

		0



		77

		 "Sensor Connection Fault Delay"

		40036

		0



		78

		 "Restarts Locked Motor"

		40037

		0



		79

		 "System Config"

		40038

		0



		80

		 "Troubleshooting"

		40039

		0



		81

		 "Analog Select"

		40040

		0



		82

		 "Program Relay 1"

		40041

		0



		83

		 "Program Relay 2"

		40042

		0



		84

		 "Program Relay 3"

		40043

		0



		85

		 "Program Relay 4"

		40044

		0



		86

		 "Analog in Reverse"

		40045

		0



		87

		 "MODBUS ID"

		40046

		0



		88

		 "MODBUS Data Rate"

		40047

		0



		89

		 "MODBUS Parity"

		40048

		0



		90

		 "MODBUS Stop Bits"

		40049

		0



		91

		 "Disable Manual Mode"

		40050

		0



		92

		 "AUX 1 Select"

		40051

		0



		93

		 "AUX 2 Select"

		40052

		0



		94

		 "AUX 3 Select"

		40053

		0



		95

		 "AUX 4 Select"

		40054

		0



		96

		 "Broken Pipe psi"

		40055

		0



		97

		 "Broken Pipe Time"

		40056

		0



		98

		 "T OFF"

		40057

		0



		99

		 "T1 ON"

		40058

		0



		100

		 "T2 ON"

		40059

		0



		101

		 "Shut Off Frequency"

		40060

		0



		102

		 "Boost Amount"

		40061

		0



		103

		 "Pre-charge Frequency"

		40062

		0



		104

		 "Pre-charge Time"

		40063

		0



		105

		 "Pre-charge psi"

		40064

		0



		106

		 "Proportional Gain"

		40065

		0



		107

		 "Integral Gain"

		40066

		0



		108

		 "Derivative Gain"

		40067

		0



		109

		 "PID Filter Gain"

		40068

		0



		110

		 "PID Filter Time"

		40069

		0



		111

		 "Overpressure psi"

		40070

		0



		112

		 "4-20mA psi Sensor Range"

		40071

		0



		113

		 "Duplex Cycle Time"

		40072

		0



		114

		 "Draw Down psi"

		40073

		0



		115

		 "psi SETPOINT"

		40074

		0



		116

		 "psi 1 SETPOINT"

		40075

		0



		117

		 "psi 2 SETPOINT"

		40076

		0



		118

		 "psi 3 SETPOINT"

		40077

		0



		119

		 "psi 4 SETPOINT"

		40078

		0



		120

		"PSI Offset"

		40079

		0



		121

		 "Number Lag Pumps"

		40080

		0



		122

		 "Stage Pump Dly"

		40081

		0



		123

		 "Destage Pump Dly"

		40082

		0



		124

		 "Stage Frq Redct1"

		40083

		0



		125

		 "Stage Frq Redct2"

		40084

		0



		126

		 "Stage Frq Redct3"

		40085

		0



		127

		 "Stage Frq Redct4"

		40086

		0



		128

		 "Stage Time"

		40087

		0



		129

		 "Destg psi Boost1"

		40088

		0



		130

		 "Destg psi Boost2"

		40089

		0



		131

		 "Destg psi Boost3"

		40090

		0



		132

		 "Destg psi Boost4"

		40091

		0



		133

		 "Destage Time"

		40092

		0



		134

		 "Stage psi Lag"

		40093

		0



		135

		 "Destage psi Lag"

		40094

		0



		136

		 "Destage Min Freq"

		40095

		0



		137

		 "Precharge Pumps"

		40096

		0



		138

		"Modbus Msg Count"

		60001

		1



		139

		"Modbus Comm Error Count"

		60002

		1



		140

		"Modbus Exception Count"

		60003

		1



		141

		"Modbus Slave Msg Count"

		60004

		1



		142

		"Modbus No Response Count"

		60005

		1



		143

		"Modbus Framing Error Count"

		60006

		1



		144

		"SCI Error Count"

		60007

		1



		145

		"SCI Framing Error Count"

		60008

		1



		146

		"SCI Overrun Error Count"

		60009

		1



		147

		"SCI Parity Error Count"

		60010

		1



		148

		"Operating Start"

		60011

		1



		149

		"Auto Restart Start"

		60012

		1



		150

		"Interface Start"

		60013

		1



		151

		"Constant Pressure Start"

		60014

		1



		152

		"Lead Lag Start"

		60015

		1



		153

		"Operating Count"

		60016

		1



		154

		"Auto Restart Count"

		60017

		1



		155

		"Interface Count"

		60018

		1



		156

		"Constant Pressure Count"

		60019

		1



		157

		"Lead Lag Count"

		60020

		1
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· http://www.modbus.org/docs/Modbus_over_serial_line_V1_02.pdf

· http://www.modbus.org/docs/Modbus_Application_Protocol_V1_1b3.pdf
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